
Version History 
If you have registered your  GTrek then you are eligible for free software updates. 
We will also inform you when updates and downloads are available. This is an 
automatic process when you run the GTrek application, if an update is available for 
the version you currently have then a message will be provided. 

Original GTrek II version 1.0.3.0 

1. Automatic update notification when new versions become available.  
2. Support for exporting Google Earth/Maps files in ZIP'ed format making them 

very much smaller.  
3. Changes to the data download algorithm to make the process more immune to missing data. A problem that 

may occur on older and slower PC's  
4. Provision for a selectable 'Y' axis on the Altitude display  
5. Modifications to the Profile page to allow either of the two graphs Altitude and Speed to be independently 

switch off and a fill facility. Go take a look you'll get the idea.  
6. In Google Earth 4.1 the process of running the tours to create a virtual fly through were changed. To 

accommodate this the export process now provides two options:-  
1. If the data gathered was on the ground ie. skiing or biking then select the Track on Ground option.  
2. If the data gathered was in the air then select the Track not on ground option. 

7. In the original version only a single analysis screen could be displayed, now many screens can be opened 
simultaneously.  

8. In the Position screen where the visible satellites can be viewed a satellite trail feature has been added so the 
satellite paths can be seen. Beware this is a bit like watching paint dry.  

9. The standard data logging intervals of 1, 4 and 6 seconds has been extended to log every 200m/s thus 
providing an update 5 time a second for application where speed is of an issue.  

10. A fully featured digital picture GeoTagging facility has been added. Users track there routes and take pictures 
for much the same reasons, to provide a record of where there have been and what they a seen. It therefore 
makes sense to combine these two technologies. The Geotagging features download and save the GTrek 
routes, Download your digital pictures from your camera and merge the two into a single file that not only 
show's your pictures but tells you when the picture was taken and where you where when you took the 
picture. The resulting file can be loaded into Google Earth so it can be shared with friend and family. 

Version 3.2 

1. Added Export to .CSV file format 

Version 3.3 

1. Minor bug fixes to the Analyse screen and Trim function 
2. Corrections for globalization errors (ie '.' instead of ',' in numbers) 
3. Bug fix in GTrek device detection logic. 
4. Bug fix in lift and hill count logic 
5. Remove "Exit GTrek, are you sure" 
6. Tab order in Trip details changed 
7. Changes to Download screen 
8. Added Save File Name on Quick Statistics screen 

Version 3.4 

1. Driver installation process changed. 
2. AGPS download system added to improve time to first fix (TTFF)  
3. Added globe image on Position screen 

So what's new for version 1.0.4.0 ? 



Well version 4 brings a complete makeover and the release of GTrek-Track a completely new application based on 
the GTrek-Bike version. GTrek-Track brings multi-route displays and calculated G force displays on the speed screen. 

1. Creation of GTrek-Track 
2. Multiple route file display 
3. Calculated G force on speed display 

 Version 4.1 

1. Minor bug fixes 

Version 4.2 

1. A change in the way Time Zones are handled to make it easier to synchronize your camera time with the 
downloaded data time used to GeoTag digital pictures 

Version 4.4 

1. Correction to the Rotate function when displaying downloaded routes 
2. Improved panning function on the route display with mouse click and drag. 
3. Increased accuracy on the Lap extraction utility. Lap times are now calculated to 0.001 seconds 

 Version 4.5 

1. Fix an error in the track data calculation of lap times.  
2. Added Right-Click function in Route Summary box to copy contents to the Clipboard  
3. Single Click to start download of data from GTrek when switch on  
4. When exporting data to Google Earth when in GTrek-Track the default Smoothing value defaults to 1 and 4 in 

GTrek-Bike and GTrek-Ski  
5. Then the Trim sliders are selected on the Trim-Data page selection indicators are displayed 

Version 4.6 

1. A new facility in the View menu on the Analyse screen "Trace Data Selection" to select/deselect traces in a 
multi trace view and select the default trace. 

2. A new facility in the Settings menu on the Analyse screen "Delete Inactive Data" to automatically identify 
and remove and data deemed to be inactive. 

Version 4.7 

1. Export to KML with multiple segments caused the second and subsequent lines to be in white, fixed. 
2. Most recent files added to main screen File menu. 
3. Miltiple route file Add function in File menu of Track analysis screen. 
4. Error in the vertical assent and decessent calculation fixed. 
5. Error in longitudinal Gforce calculation and additional thumbwheel to select sample period. 
6. Changes to detect and handle memory reset and initialisation faults. 
7. If the log rate is not an exact second then start logging milliseconds also, this will reduce the number of 

records from 122k to 114k. 

Version 4.8 

1. System changes implemented for Windows 7 compatibility. If you have an installation disk version 4.7 or 
earlier then a new disk will be required for Windows 7 installations. Go to the downloads page for details. 

2. Data download algorithm re-written to reduce the time required from a maximum of over 12 minutes to just 
over 60 seconds. 

Version 4.9 

1. Minor bug fixes. 



Version 4.10 

1. Configure GTrek tooltips added. 
2. Download tooltips altered and added. 

Version 4.11 

1. Improvements to Download algorithm to detect transmission errors and correct them. 
2. Quick Stats time totals showed incorrect data if the total time was greater than 24 hours 

Version 4.12 

1. The Quick Stats duration column now shows the pink box in the largest value for GTrek-Ski and GTrek-Bike 
but the smallest value for GTrek-Track. 

Version 4.13 

1. Minor bug fixes 

Version 4.14 

1. Changes to the logging period to select from 0.2 to 1.0 seconds in 0.1 second increments and from 1.0 to 99.0 
seconds in 1.0 second increments. 

Version 4.15 

1. Improvements to the Speed and Altitude display filter function to improve readability. 

So what's new for version 1.0.5.0 ? 

From version 1.0.5.0 the version numbering system has changed, all software releases from this point on 
will be Version 5.0.0 or above. 
 
Version 5.0 
With version 5 brought a completely reorganized data analysis screen with the ability to view not only the route data 
but altitude, speed and statistics all at the same time with the option to display a speed distribution graph by right 
clicking on the statistical data box.  

 
This version also saw the introduction of an integrated version of Google 
Earth. If you have played with the features that GTrek and Google Earth can 
provide then you are going to love this version. It provides not only all the 
features the old version provided for but in addition virtual tours with life-like 
models that follow your recorded route and it’s done in real time as opposed 
to constant data rate as in the old version. 
 
One minor drawback is 
that the new version 
requires an internet 

connection to view the Google Earth data, it won’t work without 
but we consider this a minor handicap. Take a look at the video 
links on YouTude below and see for yourself. 
 

1. A flight into the Grand Canyon - 
http://www.youtube.com/watch?v=h-PoX4Nx-so 

2. A flight from Birmingham to Geneva -  
http://www.youtube.com/watch?v=4afVevRz88Q 

3. Para-Gliding in France - 
http://www.youtube.com/watch?v=4afVevRz88Q 

4. Skiing on Blackcomb mountain in Whistler - 
http://www.youtube.com/watch?v=CKm3AujvQuk 

 



Version 5.0.1 
1. Minor bug fixes and new algorithm to remove stationary data from data stream 

 
Version  5.0.2 

1. Major revamp to the GeoTagging utility to utilize the new Google Earth API 
 
Version  5.0.4 

1. Minor bug fixes 
2. Changes to Google Earth Tour screen to add “take a picture” 
3. Additional models added to list 

 
Version 5.0.7 

1. A major software bug in the version of Google Earth API being used, version prior to 5.2.1.1588, was found 
where as the view point drew closer to the model the model would start to disappear. This version contains a 
correction to minimize this error. 

2. Camera view added to Google Earth Tours. The normal way in which a view was rendered was to specify a 
point in space and use that as a “look at” point. This approach works well and is relatively light weight control 
that requires little in processing power. However it has some limitations, you can’t look in front of a model and 
you can’t move the view point to the left or right. 
 
This version fixed these limitations by implementing a “look at” or Camera view” option. The disadvantage is 
that the camera view option requires more processing power. 

 
Version 5.0.11 

1. Additional models added 
2. Added Save and Save As on analyse screen 

 
Version 5.0.13 

1. Additional models added 
2. Version released for general download 

Version 5.1 has had some significant updates and some minor bug fixes as follows:- 

1. Changes to the Tilt, Rotate and Scale functions in the Google Tour to allow greater resolution and control. 
2. Additional models added to the Google Tour screen 
3. Updates associated with Google Earth API version 6 
4. There was a problem during the installation procedure where the GTrek device driver installation completion 

screen could get lost behind other screens giving the impression that the installation process had stopped. 
This screen is now independent of the rest of the installation process. 

5. Fix minor bug in the Speed Bars display. 
6. Additional functions added to the Statistics display screen:- 

1. New data for the Ski/Bike/Track applicable to the versions 
2. If files that have been added to the Quick Statistics are subsequently changed you will be prompted to 

update the display with the new data. Only applied to data added on or after Version 5.1.0. 
3. Option to set the distance data resolution to 1 to 4 decimal places. 

7. Changes in the way altitude changes are detected to make the system more responsive and to add a blue line 
colour to indicate no or minimal altitude change on the Google Tour screen. 

8. Changes to the Configure GTrek screen to allow the selection of the maximum logging rate to be set to 5hz or 
1hz 

9. Ability to export Google Earth data in either KML (normal data) or KMZ (compressed) file format. 
10. When data is downloaded the user is prompted to automatically set the time zone for the data to that set on 

the PC. 
11. The GTrek Track utility (available only in the GTrek-Track version) has the ability to set a Start and/or Stop 

line for the extraction of the lap data. These lines are normally set perpendicular the track data but can now be 
rotated independently. 

12. Fix bug in Analyser screen where the animation marks don't always get cleared correctly. 

Version 5.1.1 Changes mainly to the Geo-Tagging utility 

1. Corrected problem where no route would be displayed if the number of records or data points exceeded 
32,000 

2. Thumbnail pictures adjusted for landscape and portrait and for picture aspect ratios that are not standard 4:3 
3. Changed the Set Camera Time screen to make it easier to use, 



4. Changed the Geo-Tagging utility to cater for off-line support 

Version 5.1.2 Minor bug fixes 

Version 5.1.4 Enhancements to the Geo-Tagger utility 

1. Added ability to add textural information to geo-tagged images which is displayed when the data is exported to 
Google Earth 

2. Corrected screen display to cater for the display zoom option on Windows 7 

Version 5.2 Major enhancements to the Geo-Tagger utility 

1. Changes to cater for additional file types to include not only .JPG but .BMP, Canon file types .CR2 and Nikon 
File types .NEF and several common other file types. 

2. Included the new GTrek-Image Viewer utility, this is a separate program designed to view images, geo-Tag 
data and to provide slide shows. It's compatible with all the major image file type available today. 

3. Added functionality for “All User” installation option 
4. Added a Search function to find locations in the GeoTagg page in the GTrek program and a similar utility in 

the GTrek-IV image viewer. 
5. Added “Device Serial Number” to statistical data screen 
6. Added a utility to upload route files to the GTrek web servers that can be view an PC’s, MAC’s and many 

smart devices 

Version 5.3.0 Minor updates and additional features 

1. Additional facility to import .GPX file from the main screen 
2. When moving from one image to the next in the GeoTagger the view angle and range are now maintained. 
3. Error in GeoTagger when tagging images from multiple routes 
4. GeoTagger not updating all layers in Google Earth 
5. Right-click menu in data summary on main screen fixed. 
6. GTrek option selection screen added to make the installation program universal 
7. Install GTrek device driver now part of the installation process 

Version 5.3.2 Minor updates and additions 

1. Historical image view added to Google Tour display 
2. Changed to the Delete Segment screen to speed up the process 
3. Changes to the Analyse screen to display total duration and time spent going Down, Up and Flat. 

Version 5.3.9 Minor updates and additions 

1. Right click menu on summary now able to copy to the clipboard data in .CSV format 
2. Export data formats extended to Flight format files types of .GPX data as Waypoints and IGC format 
3. Additions to Quick Stats:- 

a) New columns for Down/Up/Flat times 
b) New columns for User designated data (see below) 
c) Support for Miles and Km 
d) Export data in .CSV format 
e) Option to reset columns to default order 
f) Most Resent Used files facility added to File menu 
g) Quick Stats when opened automatically opens most resent Stats file 
h) File menu Save and SaveAs 

4. Trip Details screen now has upto four selectable additional titles and data fields that can be saved and 
restored. This data impacts the Data Summary, Profile and Quick Stats screens 

5. Extensive re-write of the Profile screen which is now much faster. 
6. Profile screen now has a slideable transparency function to allow the back image to show through the trip 

data. 
7. Profile option facility to allow user to select which data is displayed as statistical data in the top boxes. 
8. Data can now be added to Quick Stats data base from the Analyse Screen 

Version 5.3.13 Minor bug fixes and changed to presentation 



1. Fix in GeoTagger for non-JPG images 
2. Error in uploading KMZ files where the file name exists. 
3. Error in the GeoTagger Sync-Time utility due to changes in US Navy time-port website 
4. Error in Delete Inactive Data utility, delete button was missing. 

Version 5.3.23 Minor bug fixes and changes to the main analyser screen and printable images 

1. Addition of Date/Time on Google Tour screen 
2. Changes to the Uninstall procedure to remove all traces of the program but leave saved routes intact 
3. Bug fix on the Speed and Altitude screens where the X axis displayed data tended to overwrite adjacent 

labels 
4. Changed to the data displayed in the first Analyser screen to incorporate Google Maps with Terrain or 

Satellite view options. This requires an internet connection, if one is not available then the display reverts to 
the normal graphical display. 

5. Changes Analyse screen view printouts to resemble the screen display 
6. Improvements to the Analyser Print functions to increase quality and functionality 
7. It has been found that the current version of Google Earth Version 7.0 has significant bugs in it and a trap has 

been incorporated into the program to detect this version and advice on a solution 
8. Fix a problem with the Time Server when synchronising the PC time in the GeoTagging screen 
9. Updated version to support Windows 8 
10. Added additional models to model list 
11. Addition of Smooth Line feature to analyse screen and performance improvements when updating display 
12. Animation screen to imperial or metric data as selected. 

Version 5.4.0 Consolidation of latest changes and updates 

1. This version sees the consolidation of the latest changes and updates 
2. The animation screen has be changed to reflect either imperial or metric instead of a mixture of both 
3. A drag and drop feature of the main screen added to open files dropped onto it 
4. Performance increase on the analyse screen 
5. Fixed an error in the update notification screen where some useres were not being notified of updates 

Version 5.4.1 Consolidation of latest changes and updates 

1. Register your GTrek from the Help menu on the main screen 
2. Minor incompatibility fixes for Windows 8 

Version 5.4.2 Consolidation of latest changes and updates 

1. Changes to increase the speed of analyse data redraw 
2. Minor incompatibility fixes for Windows 8 

Version 5.5.0 Additional features 

1. A new KMZ export feature added which provideds route, data points and speed profile 
2. Added feature to change the trace colours on the analyser screen 
3. added display of device serial number in the Trip Details page 

Version 5.5.5 Modification due to changes in latest version of Google Earth and updates for Windows 10 

1. The installation of later versions of Google Earth chnaged the name of the executable from "google Earth.exe" 
to "Googleearth.exe" and the GTrek program was not able to open GE from the analyser screen.  

2. Changes incorporated due to requirements of Windows 10  
3. Incorporate the new GTrek-GeoTagger access from the main application 
4. Add re-Install option to installation software 
5. Changes  to detect if a recent file exists 
6. Changes to Optimize to allow 1hz/5hz logging at any time 

 

Version 5.5.6 Additional features and bug fixes 

1. Version update due to changes in GTrek-GeoTagger 
2. Add Re-Centre map function to View menu on Analyzer screen 



3. Map view scroll bars removed for Maps view 
4. Changes to some forms to address high DPI 
5. Java script error on analyser screen, added &V=3.22 to js code and problem fixed 

Version 5.5.11 Additional features and bug fixes 

1. Change to make trace colours trace related and not global 
2. Extra functions to the track version for selecting and removing traces 

Version 5.5.17 Additional features and bug fixes 

1. Update for GTrek-III compliance 
2. Error in Import GPX file fixes 

Version 5.5.20 Additional features and bug fixes 

1. Addition of a utility to split downloaded data into individual files at download time. 

Version 6.0.0 Additional features and bug fixes 

1. Add help menu to QuickStats page 
2. Add function buttons to Main and Analyser page 
3. Add help menu to QuickStats page 
4. Error showing Gforce data on Track version 

 
So where can you get the new updates? Using an internet browser go to 
http://www.gtrek.co.uk/downloads/index2.html and select the preferred version and follow the instructions. You will 
need the user name and password provided when registered your GTrek, f you can’t find it then just register again. 
 


